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Motivations

@ Fluctuations in household inventories are one of the sources of
macroeconomic fluctuations.
» COVID-19, consumption-tax increases, earthquake.
» Stockpiling occurs on a daily basis, especially during a temporary sale.
» Many important consequences.
* Source of intertemporal price discrimination; financial returns;
consumption inequality; price index (chain drift)
» A difficulty in observing household inventories
@ Aims
» Propose a methodology to estimate changes in household inventories.
» Examine the validity of the methodology, focusing on the intertemporal
substitution bias in consumer price indices.
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Contributions

@ Construct a simple partial equilibrium model on stockpiling by
consumers.

» Quasi-dynamic

> Infer consumption, consumption prices, and inventories

» Construct a COLI

@ Apply our methodology to the issue of intertemporal substitution bias
in price indices.

» Show that intertemporal substitution bias disappears for a particular
type of price index if we switch from purchase-based data to
consumption-based data.

@ Apply our methodology to a range of other issues (skip today)

» The estimation of the elasticity of substitution, responses to
consumption tax hikes, and business cycles.
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Literature

@ Storable goods; household inventory

> Empiric: Boizot, Robin, and Visser (2001), Griffith et al (2009), Hendel and Nevo
(2006a), Kano (2018); Models: Boizot, Robin, and Visser (2001), Hendel and Nevo
(2006a, 2006b), Cashin and Unayama (2016);

> Relation to sales: Empirics: Blattberg and Neslin (1989), Neslin and Schneider
Stone (1996), Hendel and Nevo (2003QME); Models of stockpiling: Salop and
Stiglitz (1982), Hong, McAfee, and Nayyar (2002), Hendel, Lizzeri, and Roketskiy
(2014)

@ Chain drift in the chain index

> Frisch (1936), Reinsdorf (1999), Feenstra and Shapiro (2003), ILO (2004) etc;
Solutions proposed by Feenstra and Shapiro (2003), Ivancic, Diewert, and Fox
(2011), Haan and van der Grient (2011)

e COLI
> Static COLI: Konus (1924), Diewert (1976), Feenstra and Shapiro (2003), Chevalier
and Kashyap (2018); Dynamic COLI: Reis (2009), Gowrisankaran and Rysman
(2012), Wang (2013), Osborne (2018)
@ We propose a simple method to calculate a static COLI while
incorporating goods storability.
» A new quasi dynamic model.
» Deep investigation on the source of chain drift.
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Model
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Quasi Dynamic Model Setup

@ Storable goods
o Partial equlibrium
» Price: high (regular) or low (sales); stochastic and exogenous

@ Households consist of consumers and household producers.
@ Household producers
» purchase goods from manufacturers, hold inventories, and sell them to
consumers
» inventory cost; no depreciation; free entry
o Consumers
» do not hold inventory.
» Purchase equals consumption.
» Purchase goods from household producers and/or manufacturers.
@ The problem to solve the COLI is static,

» while propositions in Hendel and Nevo (2006a) continue to hold in the
quasi-dynamic model.
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Consumers

Hold no inventory. The consumer’s cost minimization problem:
. 11557
m'nctk{ Lrek, et + A {U— [Zker b*(cf) ” } } } (1)

where r¥ represents the consumer price of storable goods k in period t
that the consumer purchases.

This optimization problem is static.
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Household producers
A household producer maximizes the firm value:

e ] B (tots-stints-citg) )]
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The inventory as well as the purchase must be nonnegative:
xk, ik >0, (4)
and C(0) >0, C(i)) >0and C(i/)" >0
The first-order conditions with respect to x and i are
0 =rf — pf + ¢, (5)
C' (i) =BEelrisa] — rf + e (6)
Consumption price r; may differ from purchase price p;. Consumption

ye(ce) may differ from purchases x;. [ TATII T F T
T



The price of storable goods follows a Markov process. It takes either of the
two, non-sale Py or sale P, (Py > P;) and

Prob(PL|PH) = a
Prob(P.|P.) = q. (7)

Free entry: the zero value for the entrant firm with zero inventory,

VE(if ., =0,pf) <. (8)
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Equilibrium

@ Typical pattern

bp
r Posted price H
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Consumption P Consumption
i L price
P, price
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Consumption Consumption
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@ Asymmetry in the quantity purchased
> X,}, (the quantity purchased just before a sale) > XE, (the quantity
purchased just after the sale)
> X,} (the average quantity purchased during the first half of the sale) > XL2
(the average quantity purchased during the second half of the sale)
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Intertemporal Substitution Bias for Chained Price Indices

@ It is known that the Tornqvist index is a good approximation of the
cost-of-living index (COLI) (Diewert 1976).

» Changes from t — dt to t based on Laspayres, Paasche, and Tornqvist:

k
p
7Tlt_ = Z Wtk—dt(Kt—dt N Kt)log ( kt ) ' (9)
keK:_aNK: t—dt
P k Pf
=Yy, Wf(KegeNKe)log | — , (10)
keK,—_aNK: Pi—_at
Wk L (Ke—ge N Ke) + WE(Ke_ g N K, k
7TtT: t,dt( t—dt t)z t( t—dt t)log ft ’ (11)
kEK,_qeNK: Pt_dt

where the purchase-based weight share
WE(Ke—ae NV Ke) = plxt /) Curer, i, PEXE .
e The model suggets 7° < 77 < 0 < 7L,
» Because of asymmetry in the quantity purchased
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Stylized Facts Based on Japanese Scanner Data
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Data

o Retailer-side data, namely, the point-of-sale (POS) scanner data
» collected by Nikkei Inc
» The number of units sold and the sales amount (price times the

number of units sold) for each product and retailer on a daily basis.
» From March 1, 1988 to December 31, 2019.

» Processed food and daily necessities, covering 170 of the 588 categories
in the CPI and making up about 20 percent of households’ expenditure
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Fact 1. When weights are based on purchases, the relationship
between the different price indices is given by the following
inequality: 7”7 < 77 <0 < 7t
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Chain Drift Test

Large inflation or deflation may not be necessarily a bias.
Define chain drift d(f(T de as

(t—1)/dt
X X X
do,r.dt = Z TUs—1)dt,sdt — 700,01 (12)

where T represents a time span to measure chain drift and set to 365 days.
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Price indices

dt Tornqvist Tornquvist, Order r superlative
(purchase-weighted)  (consumption-weighted)  (consumption-weighted)
Annual chain drift
1 —40.447* —5.69"* —1.20
7 —7.24%* —2.28*** —1.23%**
14 —2.43%* —1.10%** —0.59***
28 —0.97*** —0.46*** —0.04
52 —0.66"** —0.20** 0.23
91 —0.61*** 0.06 0.17
182 —0.49%** 0.01 0.14
Annualized inflation rate
1 -46.34 -13.06 -10.71

Note: Chain drift is the average from 1989 to 2019. We apply the sign test for the null
hypothesis that the probability to take positive/negative chain drift is equal to 0.5. The
annualized inflation rate is calculated as exp(365 X Xg—1) — 1, where Xg;—1 is the mean of daily

log inflation from 1990 to 2018.
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Fact 2. There is asymmetry in the quantity purchased when prices

increase and when they decrease.

Xﬁ,: the quantity purchased just before a sale

X1 the average quantity purchased during the first half of the sale
Xl2 the average quantity purchased during the second half of the sale
X% the quantity purchased just after the sale

Qu = log(XZ +1/1+ (le)z) —log(X4 +1/1+ (X‘},)z): negative — Q smaller after a
sale than before it

QL = log(X? +1/1+ (Xf)z) —log(X} +4/1+ (Xﬂ)z): negative — Q smaller during
the second half of a sale than the first half of it

QH —=—
QL
1990 1995 2000 2005 2010 2015 2020
Year
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Fact 3. Chain drift is
temporary sales.

associated with household stockpiling during

Dependent variable:

Chain drift for purchase-weighted Térnqvist

1) () @) (4)
Qn 0.698**
(0.315)
QL 1.781%**
(0.463)
q —1.916%**
(0.483)
q —0.807 —2.190**
(1.039) (1.089)
q —0.708*** 0.014
(0.154) (0.259)
log(Py/Py) 3.079% 3.020%+* 2.899%+*
(0.644) (0.618) (0.673)
log m —0.344%%*
(0.101)
Constant —0.320%** 0.178%*** 0.418*** 0.223**
(0.039) (0.062) (0.075) (0.093)
Adjusted R2 0.102 0.400 0.440 0.470
Observations 189 195 195 195

Note: Qy and Q; represent a degree of an asymmetry for the quantity purchased when price increases and decreases, q is the
probability that a product is on sale, G is the probability that a product will go on sale on the following day given that it is not

currently on sale, q is the probability that a product will continue to be on sale on the following day given that it is currently on
sale, Py /Py is the ratio of the sale price to the regular price, and I HH ii
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Inference of Consumption and Consumption Prices
and Calculation of the COLI
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Motivation

o We want to know
> consumption (c¢), the consumption price (r¢) and the degree of
stockpiling (m)
* necessary for the COLI
* however, usually unobservable, unlike purchase and the posted price
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When p; = Py, household producers’ optimization problem is given by

C'(igi 1) = B{A =@ ru(l) +GPL} — ry(le—1) + e (13)

costs of holding inventories = benefits of holding inventories (price
increase)
@ When inventory cost function C(-) is written in a certain form,
ru(ly) — ry(le—1) is a positive constant.
» The expectation of a linear consumption-price increase.
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@ Consumers’ stockpiling behavior can be conveniently summarized by a
single variable: the degree of stockpiling during a sale (m)

» which expresses how long an inventory lasts after sales end.

@ Case of m=5.

PH
Consumption
P, price
| 01 2 3 45 6 7 8 ¢t
X .
Inventories
Consumption

900 0.
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Degree of stockpiling m

Calculated m is mostly a few days.
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Chain Drift at a Product Category Level
Simulation using the frequency of sales, the size of sale discounts, the
degree of stockpiling for each product category.

Simulation

y =-0.002 +1.892x

“0.0%2  r% —0.189

-0.02%5

Note: Each circle indicates a 3-digit product category. The inflation rates are daily
average and based on the purchase-weighted Tornqvist index. The red dashed line
represents the 45 degree line.
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Price Indices (Consumption Weighted)

Price indices

dt Tornqvist Tornquvist Order r superlative
(purchase-weighted)  (consumption-weighted)  (consumption-weighted)

Annual chain drift

1 —40.44*** —5.69"** —-1.20
7 —7.24%** —2.28*** —1.23%**
14 —2.43%** —1.10"** —0.59***
28 —0.97*** —0.46*** —0.04
52 —0.66*** —0.20%* 0.23
91 —0.61%** 0.06 0.17
182 —0.49*** 0.01 0.14
Annualized inflation rate
1 -46.34 -13.06 -10.71

Note: We apply the sign test for the null hypothesis that the probability to take
positive/negative chain drift is equal to 0.5. The annualized inflation rate is calculated as
exp(365 X Xg—1) — 1, where Xg—1 is the mean of daily log inflation from 1990 to 2018.
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@ Even if we use a consumption-weighted Tornqvist index, chain drift is
not completely disappeared.

Consumption path at the start and after a sale is asymmetric

Because of nonnegative constraints on both inventory and purchases

Causes a systematic higher-order approximation errors in price indices,

although it is well known that the Tornqvist price index provides a good

approximation to the COLI up to the second order (Diewert 1976).

@ The order r superlative index, where we define P, as

10\ 1/ (1-0) 103 1/(1-0)
k r],.( 2 k r(f 2
P(ro,r,cocr) =< Y s - /1Y st = )
keK o keK n

vV vy vy
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Annualized Inflation Rates
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Comparison with Rolling Window GEKS (RWGEKS)

o Multilateral index so that the circularity or transitivity requirement is
satisfied
» lvancic, Diewert, and Fox (2011), de Haan and van der Grient (2011)
and Diewert (2021)

@ The change in the RWGEKS between t — 1 and t is defined as

t
anGEKS = |0g H <Pt—1,I/Pt,I>1/d , (14)
I=t—d+1

where d represents the length of a window in days and P is the
Tornqvist index.
@ Simulation based on our model
» Given that our model is correct, how do the RWGEKS perform?
@ Data
» Comparison between our index and RWGEKS
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Simulate the paths of price indices assuming m =5, ¢ = 0.03, g = 0.50, and
P, /Py =0.9. The price level after 365 days, where the initial price level is set to one.
If there is no bias, the price level after 365 days should reach one.

coLl Order r Tornqvist Tornqvist Laspeyres Paasche RWGEKS RWGEKS

superlative (@] (Q) Q) Q) (d=30) (d=7)

(1) Benchmark 1.000 1.000 0.991 0.163 2.71e+01 1.01e-03 1.001 0.943
(4.60e-03)  (4.60e-03)  (4.58e-03) (1.09e-02) (3.80e+00) (2.10e-04) (9.11e-03)  (7.83e-03)

(2) Low m 1.000 1.000 1.000 0.448 2.73e+00 7.36e-02 1.001 0.998
(m=1) (3.88¢-03)  (3.88¢-03) (3.91e-03) (1.15e-02)  (1.02e-01)  (5.82e-03) (5.34e-03)  (4.20e-03)

(3) High m 0.999 0.999 0.992 0.054 3.42e+02 9.13e-06 1.001 0.897
(m = 10) (5.08¢-03)  (5.08¢-03)  (5.06e-03)  (6.20e-03)  (8.82e+01)  (3.15e-06) (1.22e-02)  (1.02e-02)

(4) Low o 1.000 1.000 0.999 0.177 1.71e+01 1.87e-03 1.001 0.941
(c=2) (4.29¢-03)  (4.29¢-03)  (4.20e-03)  (1.14e-02) (2.16e+00) (3.63e-04) (8.61e-03) (7.51e-03)

(5) Low P./Py 0.999 0.999 0.808 0.005 2.50e+-05 1.44e-10 1.004 0.860
(PL/Py=075) (1.48e-02) (1.48¢-02) (1.33e-02) (1.01e-03) (1.25e+05) (9.40e-11) (2.77e-02) (2.11e-02)

(6) High g 1.001 1.001 0.980 0.005 1.87e+05 1.46e-10 1.002 0.937
@=1/7) (6.06e-03)  (6.06e-03)  (5.94e-03) (3.50e-04) (4.24e+04) (2.59e-11)  (7.30e-03)  (1.23e-02)

(7) High ¢ 1.000 1.000 0.991 0.163 2.71e+01 1.01e-03 1.001 0.943
(g=05) (4.60e-03)  (4.60e-03)  (4.58e-03) (1.09e-02) (3.80e+00) (2.10e-04) (9.11e-03)  (7.83e-03)

Note: The table shows the means of the price levels after 365 days, where the initial price level
is set to one (so that a value of one indicates no change). RWGEKS represents the rolling
window Gini, Elteto, Koves, and Szulc (GEKS) index. Standard deviations in parentheses.
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Concluding Remarks

@ Summary

» Provided some evidence of household inventory, and they are consistent
with theory
» Inferred consumption/stockpiling

* Bias is mitigated by constructing consumption-based indices.
» Stockpiling should not be ignored in business-cycle studies (not
presented today).
» Use of interesting household scanner data (not presented today).

@ Remaining tasks

» Heterogeneity wrt products and households
» Other product categories (gasoline, car, PC, travel)
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Some Other Results
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On Use of Lower Frequency Data

@ The use of lower frequency data alone does not completely eliminate
the bias.

@ Using both lower frequency data and fixed base indices ignores some
products that are short lived or new.

@ Some of the high frequency (e.g., daily) fluctuations in prices and
quantities may be closely related to business cycle fluctuations.
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Household-side Shoku-map data (food map)

@ Respondents: mainly housewives, 400 households each month
@ Daily from Sep 1998 to present

@ Food only

@ Records

» who, what, when and where purchased, when consumed, when
consumption ends

» no price information

» not on how much (i.e. weights) consumed

@ Example: a salt product for a household

F Initial consumption Consumption flag

F [ L1 e I | I 0L 01 £ o e A | N O R N O W

L| Purchase Last consumption

0 20 40 60 80 100 120 140
Days
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A beer product for a household
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Fact 4. Consumption tends to decrease as household inventories
decrease.

@ We estimate the following equation for the sample of Aj; > 0:

Yijt = Ci + dj + alNjit + €jje, (15)

for household i in product category j at date t.

> yjjt is consumption. It takes one if goods in product category j are used.
Alternatively, we define yj;; as the sum of uses of goods in product category j.

> Ajj is the sum of inventory. Suppose that household i uses goods k in date
t) € t1, to, -+, tp,, Where t represents the purchase date. Thus, nj
represents the number of uses. We define the inventory in date t
(t < t < tny.) as A = Nike — 27’:“1 1. Then, aggregating it in product
category j leads to

Ajje = Y ke (16)
kej
o Is « positive?
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Table: State-dependent Consumption

Dependent variable 1 if household uses product Number of times a product is used

Inventory 0.0006895*** 0.00410%***
(0.0000171) (0.000901)
Observations 90,545,020 90,545,020
No. of HH 3,602 3,602
R? 0.12 0.12
Fixed effects HH /category HH/category

Note: Figures in parentheses represent robust standard errors. *** ** and * indicate
significance at the 1%, 5%, and 10% levels, respectively.
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Elasticity of Substitution

@ We obtain o for each 3-digit product category.
» V shape filter to identify sales.
» for each sales event s of product k and shop s, obtain Py, Xy, Pr, X
(the lower of the quantity purchased in the first- and second-half spell
of sales).
» calculate o for each 3-digit product category.

* —log (X/X) /log (PL/ Ph).
@ For each sales event s of product k and shop s, we obtain
» Consumption at sales: X/ = (P./Py)" % Xy
» Inventory at the end of sales: /| = ZJ-TleHJ- - TX/.
» ry(l;_1) and m
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Elasticity of Substitution

Our estimate
© Simple estimate

Number of categories
Our estimate

LN Pt i
° J \_r o Latar
5 o 5 10 15 20 o 5 10 15 20 25
Elasticity of substitution Simple estimate

Note: “Our estimate” represents our calculation of the elasticity of substitution o from
I'= —log(cy/cy) /log (r./ry) using the inferred series of consumption ¢ and
consumption price r. “Simple estimate” represents the calculation of ¢ from

—AlogX: /Alogp:, where X and p represent the quantity purchased and posted price,
respectively. The left-hand panel shows the histogram of the values of ¢ for 3-digit
product categories, while the right-hand panel shows a scatter plot where each dot
represents a 3-digit product category.

Ueda, Watanabe, Watanabe Household Inventory and Prices Ottawa Meeting 30/30



Table: Top and Bottom Five Categories for the Degree of Stockpiling

Product category m ‘ Product category m
Top 5 Instant cup noodles 4.98 | Bottom 5 Razors 1.15
Diluted beverages 3.74 Prepared bread meals  1.19
Frozen meals 3.58 Cosmetic accessories 1.26
Packaged instant noodles  3.23 Home medical supplies 1.27
Coffee beverages 3.08 Batteries 1.30

Note: The degree of stockpiling m is inferred using the POS data.
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External Validations

@ Comparison of the inflation rates: data and simulation

@ Comparison with the household-side scanner inventory data
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Comparison of the Inflation Rates: Data and Simulation

@ Data
» The daily average of the inflation rate from January 1989 to December
2011 based on the purchase-weighted Tornqvist index for each 3-digit
product category j (denote 7;).
» At the same time, we record the mean of the following variables for
each 3-digit product category: mj, g, gj, and (P./Py);.

@ Simulation
» Using the above values, we simulate the model and calculate the
average size of the chain drift, where ¢ is set at 5.
» We generate randomized price paths for the period of T = 405 days
and discard the first and last 20 days to calculate changes in the price
indexes in 365 days. We repeat this for N = 100 times.
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Relation between Shoku-map data and the estimate of m

No correlation between log(inventory period) and logm over the entire observation
periods

— m does not necessarily represent storability.
But a significant correlation just before the consumption tax increase

Comeldion ol 06 . CcometdidW
04 1

0.2

log(m) from POS

YoY difference of log(m) from POS

2 3 4 1 2 3 4
Tog(tyt+1) from Shokumap log(t-t+1) from Shokumap
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Relation between Shoku-map data and the estimate of m

Positive correlation between log(the quantity of purchase) and logm over the entire
observation periods

— m captures stockpiling when price decreases (or is expected to increase).

1.4
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Developments in Consumers’ Stockpiling Behavior

s in log(m) regression

Time fixed effect d; for the regression of log (mjt) = ¢j + di + AXjt + €,
where Xj;= {log (1 — Gj), log <1 —@) , log (P — PL)/Pr)j}-

EEBRGIARFIAREIAN NGRS
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Determinants of m

o Prices X;= {log (1 — @), log (1 - %) log (P — PL)/Pr)ic}
@ Labor market conditions: hours worked, unemployment rate

» Longer hours worked may increase m, if an increase in income
alleviates financial constraints (positive sign)

» Longer hours worked may decrease m, if a decrease in shopping time
prevents search for sales (negative sign).

@ Interest rate (negative sign)

» A higher interest rate increases the opportunity cost of stockpiling,
decreasing m.
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Regression of Stockpiling m
We estimate the following equation:
Alog (mj) = ¢j + BAZ; + AAXj: + e, (17)

or

Alog (mjt) = ¢j + BAZ: + Avje + g, (18)
where j and t represent a 3-digit product category and a month,

AXjs = ej + DAZ: +vjs, (19)
Ve = AXje — (8 + DAZ,). (20)

Xir= {log (1 — ), log (1 — @) , log ((Pn — P)/Ph);;} and exogenous
variables associated with business cycles Z; consist of the unemployment
rate, log hours worked, and the real interest rate.

Using Vj;, we evaluate the overall effect of AZ; on Alog (mj), which

incorporates the indirect effect through A)<Jt Dj:DI[D]]]]IDII:D]]
TR



1) () (3) (4) 5)
Alog(m) Alog(1—7) Alog(1—q) Alog(1— Py /Py) Alog(m)

A(unemp rate) 0.0026 -0.0017*** -0.0338*** 0.0277*** 0.0312%**
(0.004) (0.000) (0.003) (0.003) (0.003)

A(unemp rate(-1)) -0.0106*** 0.0007*** 0.0244*** -0.0300*** -0.0327%**
(0.004) (0.000) (0.003) (0.003) (0.004)

Alog(hours worked) -0.2940*** 0.0210%** 0.1341%** 0.1989*** -0.3612%**
(0.043) (0.002) (0.030) (0.033) (0.043)

Alog(hours worked(-1)) -0.6677*** 0.0077*** -0.6106*** 0.4365%** -0.2602%**
(0.046) (0.001) (0.044) (0.040) (0.044)

A(real r) -0.0133*** 0.0009*** 0.0147*** -0.0052*** -0.0243***
(0.003) (0.000) (0.002) (0.002) (0.002)
A(real r(-1)) -0.0036* -0.0002*** -0.0086*** 0.0037** 0.0024
(0.002) 0.000 (0.002) (0.002) (0.002)

Alog(1 —7g) -2.4013%%* -2.4013%%*
(0.615) (0.615)

Alog(1—q) -0.5117*** -0.5117***
(0.036) (0.036)

Alog(1— Pr/Py) 0.2604*** 0.2604***
(0.032) (0.032)
Fixed effects category category category category category
Observations 53,700 53,700 53,700 53,700 53,700

Within R2 0.289 0.008 0.008 0.005 0.289
# of categories 150 150 150 150 150

Note: Variable m is the degree of stockpiling, G is the probability that a product will go on sale on the following day given that
it is not currently on sale, g is the probability that a product will continue to be on sale on the following day given that it is
currently on sale, Py /Py is the ratio of the sale price to the regular price, and real r is the real interest rate. In column (5), the
explanatory variables corresponding to Alog(1l —7q), Alog(1 — q), and Alog(1 — P, /Py) are the residuals of the estimation for
columns (2), (3), and (4), respectively. ***, ** and * indicate significance at the 1%, 5%, and 10% levels, respectively.
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